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Color Separated Photo Effect 

In this lesson, you’re going to learn how to create a photographic effect that I see 
quite frequently, both online and in print. The effect is created by taking a pho-
tograph and making it look as if the colors are selectively out of register. It is a 
process that involves using channels.

I am first going to show you the manual, step-by-step way of doing it, but know 
that I am also going to provide you with some actions that will automate much 
of the work. 

Convert Channels into Layers (Timestamp 1:45)

Behind the scenes, a photograph is made out of red, green and blue light. You 
can see that in Photoshop’s Channels Panel, which is grouped with the Layers 
Panel. (If the panel is not visible on your interface, you can open it by clicking on 
the Window menu and choosing Channels.) You’ll need to take each of the three 
color channels and convert them into layers so that they will be easier to manip-
ulate in Photoshop. 

These are two examples from Pinterest, of the effect we’re going to create. 
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1. Create selection of the channel With the Channels Panel open, hold down the 
Command key (Ctrl on Win) and click on the thumbnail for the Red channel. 
The “marching ants” selection will appear on the image. This selection is based 
on the brightness of the channel, where white areas are selected and black 
areas are not. 

2. Create layer based on the selected channel Now you’ll need to create a layer 
that is filled with red, based on the selection. Click on the Adjustment Layer 
icon at the bottom of the Layers Panel (It looks like a circle that is half black/
half white.) and choose Solid Color from the pop-up menu. The Color Picker 
will appear. The color needs to be pure red, so enter 255 into the Red field, 
leaving the Green and Blue fields set to 0 (zero). Click OK to close dialog.

FAR LEFT: In the 
Channels Panel, you 
can see that the  
image is made up  
of red, green and  
blue light.

DIRECTLY LEFT: A 
selection was made 
of the red channel 
by holding down the 
Command key and 
clicking on the  
channel thumbnail.
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3. Change blending mode of color layer This layer needs to act like light in or-
der for the effect to work. Click on the Blending Mode menu at the top of the 
Layers Panel and choose Screen. The Screen blending mode causes the layer 
to act like light.

4. Temporarily hide red layer Before repeating the process for the green and 
blue channels, turn off the visibility for the color layer that was just created and 
make sure the original image layer is active again.

A solid color layer is being created for the red channel. In the Color Picker, we entered 255 
into the red field and 0 into the green and blue fields. 
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5. Repeat process for the Green channel Repeat steps 1 through 4 using the 
green channel. When creating the solid color layer, enter 255 into the Green 
field, leaving the Red and Blue fields set to 0. 

6. Repeat process for the Blue channel Repeat steps 1 through 4 using the Blue 
channel. When creating the solid color layer, enter 255 into the Blue field, leav-
ing the Red and Green fields set to 0. 

The blending mode of the red layer is being set to Screen.
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Create Underlying Layer Filled with Black (5:45)

1. Click on the Adjustment Layer icon at the bottom of the Layers Panel and 
choose Solid Color. When the Color Picker appears, set each of the R, G and B 
fields to 0 (zero) and then click OK. 

2. Drag this new black layer so that it’s positioned beneath the red, green and 
blue layers in the Layers Panel. 

3. Take the layer mask that’s attached to the black solid color layer and drag it to 
the Trash icon at the bottom of the Layers Panel. (This step is optional, but I 
feel it’s good practice to discard any masks that are not doing anything.)

Downloading and Loading the Photoshop Action (6:35)

With this lesson, I have included an 
action that completes all of the above 
steps. You can download it from the 
course page on the Masters Acade-
my site. The file will be compressed 
in a zip format. After you have down-
loaded the file, you will need to dou-
ble-click on it to expand its contents. 
To install the action, double-click on 
the expanded .atn file. Photoshop 
should come to the forefront on your 
computer, indicating the action has 
been installed. (Note that there will 
be no indicative message that pops 
up.) If you expand the Actions Pan-
el, you should see the newly-installed 
actions at the bottom of the action 
list. They are in a folder, titled “Bens 
Color Separations as Layers.”

The downloaded actions folder will appear in 
the Actions Panel after being installed.
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If, for some reason, the actions are not installed, you can manually install them by 
clicking on the little menu in the top right corner of the Actions Panel and choos-
ing “Load Actions.” You’ll be prompted to navigate to the location of the actions 
file on your hard drive. Make sure you choose the file ending in .atn and not the 
zipped file. 

Running the Action (9:04)

Expand the “Bens Color Separa-
tions as Layers” folder (in the Ac-
tions Panel) and you will see that 
it includes several actions. The first 
action, titled “1 Layer to RGB,” will 
produce the same end result as 
steps that were detailed above. 

To run an action, click on the name 
of the action to make it active. Then 
click on the little Play button at the 
bottom of the Actions Panel. 

Move the Color Layers out of Alignment (9:38)

Now that the three color channels are on different layers, you can get creative 
with them. Here are some of the things you can do:

You can move the layers so that the colors are out of register, or no longer aligned. 
To do this, click on one of the color layers to make it active and then use the Move 
Tool to click and drag on the layer, repositioning it. Do the same thing for the oth-
er color layers. 

To run an action, click on the action to make it  
active and then click the Play button (circled).
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We moved the layers in the video example and you can see that we ended up 
with vibrant colors on the image edges. This will happen any time you have an 
almost-white background in your image. If that’s the case, you can prevent it by 
using a different action. Use the action titled “1 Layer to CMY,” which stands for 
Cyan, Magenta and Yellow. The results will look the same but you won’t get the 
vivid colors around the edges.  

TIP: Use the “1 Layer to RGB” action when your image has a dark background and 
use the “1 Layer to CMY” action when your image has a light background.

Warp the Color Layers (11:45)

The technique above allowed us to move each of the three color channels inde-
pendently of one another. There is another technique where we don’t move the 
entirety of a layer. Instead, the Warp command can be used to move some parts 
of a layer more than others.

LEFT: All three color layers are in alignment. RIGHT: The Move Tool was used to reposition 
the three color layers, moving them out of alignment.
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Activate one of the color layers, click on the Edit menu and choose Transform > 
Warp. You will see that transform handles appear around the layer. You can now 
click and drag within the image and the part of the image where you click is the 
part that will move when you drag. The rest of the image will stay in place. Tap the 
Return/Enter key to lock in the transformation. Now you can repeat the process 
with the other color layers, warping them independently of one another. 

In the video example, we wanted the subject (near the bottom of the image) 
to stay in place while we shifted the colors in the background of the image. We 
warped the color layers by clicking within the image, near the top, and shifting 
the colors. Because the subject is at the bottom of the image, the colors are not 
shifted in that area. 

LEFT: The three color layers were moved using the Move Tool. CENTER: Instead of using the 
Move Tool, the Warp command is being used to move the top right part of the blue layer. 
RIGHT: The Warp command was used to move the top area of all three color layers. The  
bottoms of the layers remained in place. 
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Puppet-warp the Color Layers (13:23)

The Puppet Warp command provides another way of moving the color layers in-
dependently of one another. If you are going to use this feature, however, you will 
need to prepare in advance. 

In the actions folder I provided, there are two actions that are designed to pro-
duce results that can be used with the Puppet Warp feature.

The actions are:

• “1 Layer to RGB for warping” 

• “1 Layer to CMY for warping” 

If you run one of the actions we used previously and then try to use the Puppet 
Warp command, you will see that there will be an issue. If you plan to use this 
feature, you will need to separate the color channels by using one of these “for 
warping” actions. These actions will create color layers that do not have layer 
masks attached to them. 

After running one of these “for warping” actions, activate one of the color layers, 
click on the Edit menu and choose Puppet Warp. By default, a mesh will appear 
over the image. If you don’t care to view this mesh, turn off the “Show Mesh” 
check box in the Options Bar (above the main image window). 

Now choose which parts of the im-
age you would like to look normal. 
These are the parts where the col-
ors will stay in alignment. You are 
going to place pins on those areas 
that you don’t want to change and 
those pins will lock the positions 
of those areas. That way, you can 
warp other areas of the layer and 
the pinned areas will stay in place. 

The Puppet Warp command is being used to place 
pins on the areas we want to remain in place.



Color Separated Photo Effect © Ben Willmore, All rights reserved 11

Click on the areas you want to stay in place. You will see little pins appear on 
those areas. Then, click and drag on an area you want to reposition. This will place 
a pin and then move it, repositioning the layer. You will see the color shift posi-
tions, depending on which color layer was active. When you’re satisfied with the 
color you were working on, tap the Return/Enter key to lock in the transformation 
and remove the Puppet Warp pins. 

Now you can repeat the process with the other color layers. 

With the red layer active, 
we clicked to place a pin 
and then dragged that pin 
to move the targeted area.

All three of the color  
layers were manipulated 
in different ways while the 
central part of the layers 
stayed in place.
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Create the Effect with Multiple Images (20:30)

There is another way of creating this effect and that is by using three images. 
There are two actions included in the provided actions folder that will allow you 
to do this. 

The actions are: 

• “3 Layers to RGB (no Background)”

• “3 Layers to CMY (no Background)”

When we created the effect using one image, each of the three color channels 
were turned into individual layers. When using three images, we take the red 
channel from the first image, the green channel from the second image and the 
blue channel from the third image. That’s what these actions do. Note that you 
can not have a locked background layer when running these actions.

In the video example, we have three images where the background is the same 
but the subject is in different positions. That’s going to create an interesting ef-
fect when we separate the colors.

You will need to start by placing the 
three images in a single Photoshop 
document. Select the layers in Bridge, 
click on the Tools menu and choose 
Photoshop > Load Files into Photo-
shop Layers. Photoshop will come to 
the forefront and all three images will 
be stacked as separate layers in a sin-
gle document. 

NOTE: If you are using Lightroom, 
you would select the images, click on 
the Photo menu and choose Edit In > 
Open as Layers in Photoshop…” 

Three images were loaded as separate layers in 
a single document.
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If the image has a light background, you will use the “3 Layers to CMY” action. If 
the image has a dark background, you will use the “3 Layers to RGB” action. Click 
on the name of the action to make it active and then click the Play button. 

You’ll end up with three layers, where each image uses a different color channel. 
Anything that was in motion in the scene is going to take on a different color be-
cause it’s out of alignment. 

Applying the Effect to Text (25:35)

This color separation effect can also be applied to text. In order for this to work, 
you will need to flatten the image so that the text is not still a layer that can be 
edited. Use one of the actions that starts with “1 Layer…” based on whether your 
image has a dark or light background. 

Use Filters to apply effects After creating the layers, you can use filters to create 
some unique effects. You will need to apply the filter to the layer mask, so make 
sure that the mask is active, and not the layer itself. You can tell that the mask is 
active because it will have little white brackets around its thumbnail. If the layer is 
instead active, simply click on the mask thumbnail to make it active. 

Each of the three images has a different color channel applied. The image looks normal in the 
areas that are aligned.
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Motion Blur With this filter, it is only through this motion blur that the text layer 
will be out of alignment. You can apply the Motion Blur filter to each of the three 
layer masks, changing the Angle and/or Distance setting for each one. 

You can even take this a step further by using blending modes. Drag the original 
image (the bottom layer) to the top of the layer stack. You may need to unlock 
the layer in order to do this. When it’s at the top, it’s going to completely ob-
scure the view of what’s underneath. The trick is to change the blending mode 
to change the way the layer interacts with the layers beneath it. You can either 
manually use the blending mode menu at the top of the Layers Panel, or you can 
use a keyboard shortcut to cycle through the layers. The Move Tool must be ac-
tive in order for this shortcut to work. Hold down the Shift key and then use the 
plus and minus keys ( + - ) to cycle through the different blending modes. The 
different modes will create different types of effects.

The Motion Blur Filter us being applied to the layer masks for each of the three color layers.

The original image layer was moved to the top of the layer stack and the blending mode was 
set to Darken. This limits the color effect to the inside of the bright type.
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Warping text You can also apply the Warp command to the three different col-
ored text layers. With the first color layer active, click on the Edit menu and choose 
Transform > Warp. Then, click and drag within the layer to warp different areas. 
Click the Return/Enter key to lock in the transformation. Then, do the same thing 
with the other two color layers. 

The blending mode  
of the top, original  
image layer was set  
to Lighten.

The blending mode  
of the top, original  
image layer was set  
to Subtract.

The three individual color layers were warped independently of one another. 
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Change the Colors of the Layers (32:58)

If you used one of the techniques or actions that creates three solid color layers, 
you can easily change the colors. You’re not limited to using red, green and blue 
(or cyan, magenta and yellow). 

To change the color of one of the layers, double-click on the color swatch for the 
Solid Color Layer in the Layers Panel. The Color Picker will appear and you can 
use it to change the color. 

If you do change the colors, know that the unchanged parts of the image (the 
areas that were in alignment) will no longer look like a normal photograph. For 
this reason, I find that changing the colors can be most effective when working 
on a white background. 

We double-clicked on the color swatch for the Solid Color layer. This called up the Color  
Picker and we’re using it to change the layer’s color.
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Selectively Apply Original Image (34:27)

It can be useful to keep the original image that was used to create the separated 
color effect because you can use it to adjust the effect. To do this, drag the origi-
nal (bottom) image layer to the top of the layer stack. Then add a layer mask that 
is completely black. You can create a black layer mask by holding down Option 
key (Alt on Win) and clicking the Layer Mask icon at the bottom of the Layers 
Panel. When a mask is completely black, it means that it is completely hiding the 
layer it’s attached to. 

Now, you can activate the Brush Tool and use a soft-edged brush to paint with 
white on the layer mask. By painting with white, you are revealing areas of the 
layer. By bringing back parts of this original image, you will be selectively hiding 
the color effect. 

You can also experiment with the opacity and blending mode of this top-most 
original image layer. 

The original image layer was placed at the top of the Layers Panel and a black mask was 
added, hiding the layer. Here, we are painting with white on the mask in order to selectively 
reveal parts of the layer.
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Use Layer Masks to Hide Parts of the Color Layers (37:31)

This technique can be used on the color layers that result from using one of the 
“for warping” actions. These actions create three individual color layers that do 
not use layer masks. 

Run one of these “for warping” actions and then add layer masks to each of the 
resulting layers. Add a layer mask to an active layer by clicking the Layer Mask 
icon at the bottom of the Layers Panel. The mask will be white by default, which 
means that the entire layer is visible. 

Then, activate the Brush Tool and paint with black on one of the Layer Masks. This 
will prevent the color from applying in the area where you paint. 

Wherever you allow all three of the color layers to apply, the image will look nor-
mal. It’s the areas where you paint with black that the color will be shifted. 

The “for warping” action was used, which resulted in three color layers. A mask was added to 
each layer and we painted with black on the masks in different locations for each layer.


